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Introduction
American Innovations (AI) is pleased to announce version 7.7.2 of our Pipeline Compliance System (PCS)
software. This document includes information for the following items:


PCS 7 Best Practices Reminder



PCS 7.7.2 Improvements (page 2)



Release History (page 3)



Product Support and Training (page 18)

If you have questions or need additional information, contact PCS Technical Support at
pcstechservices@aiworldwide.com.

PCS 7 Best Practices Reminder: Protection from Data Loss or Corruption
Despite our best efforts to prevent and protect PCS data from corruption or loss, data loss will always
remain a possibility. PCS may be used in ways that were not anticipated, data sets may become more
complicated than we predicted or tested against, machine or network failures may corrupt the PCS
database, and users may accidentally change or delete vital information.
There are simple measures you can take to protect your company’s data.


Backup your database regularly — it is important that you backup your database on a regular
basis so the database used for recovery or restoration contains recent data. In addition, we
recommend that you backup your database under these scenarios:


Upgrades: Before upgrading PCS 7.



Bulk Data Changes: Before performing a bridge import or synchronizing your database.



Considerable Data Updates: After making a lot of changes to PCS 7 data.

Refer to either the PCS 7 Installation document or the PCS Version 7.7 User and Administrator Guide
for instructions detailing how to backup the PCS database.


Backup your .dat files — before importing data from a field computer, we recommend you save a
copy of your .dat files on your computer to serve as a backup. If an error occurs during the field
computer import, the .dat file backup can be used to identify the cause of and fix the error.
Refer to Copy a PS Survey to a Computer in the Allegro User Guide for detailed instructions.
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PCS 7.7.2 Improvements
Software fixes available in PCS 7.7.2 include the following:


Site numbers correction — A defect was discovered that may impact .DAT files created and
exported by PCS 7.7.1 when using multiple scheduling facility types. During the export file creation,
if a single facility is included multiple times (the facility is due more than once in the defined time
period) it will associate the inspection values with an incorrect site number. Version 7.7.2 of PCS
resolves this defect and, before importing the data into the database, will verify that any .DAT file
being used to import data via Field Computer Receive has not been impacted by this defect.
If you need to import an impacted .DAT file, please contact AI Technical Support at
pcstechservices@aiworldwide.com or 1-512-249-3453.



Compatibility with the Allegro QX version 6.1 and MX 5.3 — A defect was discovered that
resulted in incorrect data entered in new reading fields if multiple new sites of the same facility type
were imported from the Allegro QX 6.1 or Allegro MX 5.3. This defect only exists when using PCS
7.7.1 with the Allegro QX or MX versions 6.1 or 5.3 and is corrected in 7.7.2.



Performance when selecting data — Selecting large data sets that includes scheduling data had
poor performance and occasionally resulted in an error message. The performance when using
large data sets in PCS has been improved in 7.7.2 and the errors were eliminated.



Error handling for invalid survey months — If the First Survey Month was set to 0 (an invalid
value), PCS 7.7.1 could not perform scheduling calculations and resulted in an error. This was fixed
in 7.7.2 so now First Survey Month values of 0 are corrected to become 1 (January).
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Release History
PCS 7.7.1 / Aug 2016
Software enhancements and fixes available in PCS 7.7.1 include those described in the following list:


Field Computer Send Changes — The following features were added to Field Computer Send to
create prompts that will aid in navigating between survey records on the Allegro:






Odd/Even Addresses in Sorting Themes — A new Sort By option is available when creating a
new Sorting Theme that sorts even address numbers before odd address numbers. This new
sort allows an Allegro user to complete surveys without having to cross the road after each site.
Look for Address (Odd/Even) in the Sort By dropdown.
Selectable Sorting Themes in Field Computer Send Prompts — Multiple sorting themes
can now be sent to the Allegro, allowing the Allegro user to change the sort order of the sites to
one of the included sorting themes while using the field computer. If Selectable Sorting Themes
are not defined in the Field Computer Send prompt definition, the PCS user will only be able to
select a single sorting theme when sending data to the Allegro. For more information about
Selectable Sorting Themes, refer to the Field Computer section of the PCS User and Admin
Guide.
Searchable Fields in Field Computer Send Prompts — Field Computer Send prompt
definitions now include searchable fields. Searchable fields allow an Allegro user to search for a
survey based on values in searchable fields while using the field computer. For more
information about searchable fields, refer to the Field Computer section of the PCS User and
Admin Guide.

IMPORTANT: To use these new features with a field computer, the prompt definitions must be
sent to an Allegro MX with version 5.3 or newer installed or to an Allegro QX with version 6.1 or
newer installed.

PCS 7.7 / Aug 2015
Software enhancements and fixes available in PCS 7.7 include those described in the following list:


Bridge Import




Filtering in the Bridge Preview has been improved and the ability to export the filtered preview
is now supported.
Legend buttons in the Bridge Preview now include a record count, showing the total number of
records for each filter display.



Imports from spreadsheets can now map headers in spreadsheets to column names.



Precision handling has been improved for Milepost-based matches.



General improvements have been made for importing Microsoft Excel .xlsx files.
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The Exception Filter field value is no longer truncated to 50 characters in the report output.
The Structure Readings Meet Criteria field will now return null (blank) for any non-Test Point
data.

Summations can now be reordered in Summary themes. To reorder a summation, click the up
or down arrow to the left of the summation.
Filtering on Indicate Survey in Comparison Reports is now allowed, but it is still not
recommended. A better filter for this purpose would be to use the Inspection Date range or
higher level filters.
The Calendar view in the PCS Schedule Report no longer returns an error.

Delinquency Date Reporting


Delinquency Date filters no longer block records that cross module boundaries.



Multiple scheduling types are now supported.









The rules for importing anodes and negatives now match the rules established for editing data
in the grid. The shunt factor, shunt rating, and shunt resistance for anodes and negatives are
blocked when setting up an inspection import. To import these fields, use the associated
information level import.

General Reporting




Column names that contain special characters in .xlsx, .xls, and .csv files are now allowed for
import-only bridges.

Changes to the calculations for Time Between Surveys, using new Effective Dates, have been
implemented.
The column list and report options have been improved to provide better organization and
clearer instructions when creating reports.
Date values that are earlier than January 1, 1752 are now automatically changed to January 1,
1952 to prevent crashes during calculations.

Scheduling



Improvements have been made to the calculations used for Time Between Surveys.
Inheritance rules for Scheduling Type Inspected can now be defined via the Default Schedule
Facility Type Inspected column in Edit Schedule Settings.


A new defined expression called Survey Text contains Annual Survey was created for the
Annual Rectifier scheduling type. This expression controls when the Annual Rectifier
scheduling type as the default Scheduling Type Inspected rather than the Periodic Rectifier
and relies upon the new Survey Text calculated field.
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The defined rule to be used for Scheduling Type Inspected is determined based on the
following:


The inheritance in Schedule Type Inspected is based on the lowest priority Schedule Type.



The highest priority Schedule Type that is both defined and evaluates to true is used.











Extra changelog records are no longer created when using the Add dialog.
Synchronizations were optimized to allow synchronization of a larger number of changes for an
individual record.
Memo files in the master and replica can now be packed manually, using a new Pack Memo Files
option, or automatically between replicas and after synchronization is complete.
Validation of folder paths are now performed prior to building replicas.

Data Entry




The lowest priority type is used if either no expressions are defined or no expressions
evaluate to true.

Synchronization




Additional expressions can be defined and installed expressions for Annual Rectifier can be
overridden.

Inherited values are now displayed in a grid search when no overriding value is defined.

General Improvements




For clients that use Series, the installed sorts in Field Computer > Send now use the Relative
Milepost, rather than Milepost.
File exports now handle numeric overflows by setting out of range numbers to the minimum or
maximum allowed value, similar to general reporting.



Negative and Anode Names can now contain up to 20 characters.



Memo files can now be packed manually using a new Pack Memo Files option in the File menu.

PCS 7.6 / May 2014
Software enhancements and fixes available in PCS 7.6 include those in the following list:


All PCS Modules


Custom Facility Types in PCS Installed Modules: PCS installed modules now support
custom facility types. Use Custom Module Management to add or remove a custom facility type
(Module > Custom Module Management). For example, adding a custom facility type labeled
Pig Run in the ICM module provides data entry grids and other functionality such as routing,
reporting, and scheduling.
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Note: A PCS installed module is a module that has been installed during the PCS software
installation. These include CPDM, ISM, VM, ACM, ILIM, ICM, PCM, PLSM, LSM, and PIM.










Mini-Grid Data View: Clicking the
data view button in the title bar of a mini-grid opens
the Data View window where you can choose which fields to include or exclude in a mini-grid.
For example, you can now choose which fields to include in the Scheduling Facility Types minigrid when working in the Information data grid. This feature also applies to the mini-grid in the
PIM module as well as those in the CPDM module.
Inherited Values: Inherited values is a feature that simplifies data input when entering data in
PCS data entry grids. It allows a user to select an item in a drop-down list for one field, and then
have PCS automatically populate another field with an inherited value. Each item available for
selection in the drop-down list maps to a specific inherited value. Property settings for
inheritance include mapping of two fields in Field and UDF Customizations and then setting
inheritance properties for these fields in Validation Tables.
Long Name Support: Hierarchy name, ROW Code, and ROW Name support up to 100
characters.
Import Data (File Menu): Using the File menu command Import Data now imports data
correctly.
Edit Data by Schedule: The following message displays when data changes are made in the
“Scheduling Facility Types” mini-grid of “Edit Data by Schedule” (Data Entry > Edit Data by
Schedule):
You have changed Scheduling Facility Types settings. Please click “Generate” to refresh the generated
schedule.







Scheduling Facility Types Mini-Grid: The mini-grid does not display “green bars” if the latest
information record is not selected or the facility is inactive.
Scheduling Facility Type Inspected (inspection field):


Displays an inherited value showing the internally calculated default value.



Displays “<error>” when the field value links to a “Scheduling Type” that no longer exists.

All PCS Modules, continued








Scheduling: The data grid fields “Days Until Delinquent” and “Delinquent Date From Schedule”
calculate properly when the field Installation Date is used in the calculation.
Define Routes Import, Export: Define Routes supports Microsoft® Excel® file formats Excel
Workbook (*xlsx) and Excel 97-2003 Workbook (.xls) when importing and exporting a route.
Delete ROW: A “Confirm Delete” message displays prior to deleting a ROW. The message
identifies close interval surveys associated with the ROW to be deleted.
Dynamic Forms: Text boxes are now larger by a few pixels to allow for correct display of text
that includes underscores, such as “My_Form_Label”. For existing forms, resize text boxes using
the form editor to take advantage of changes made in text box sizing.
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Reports:











Export: Supports Microsoft Excel file formats Excel Workbook (*xlsx) and Excel 97-2003
Workbook (.xls).
PCS Delinquency Report: When changes are made to the inspection interval for Months
Between Surveys, the appropriate inspection interval is now used to determine
delinquencies.
Columnar Reports: An error no longer occurs when one or more values are out of range.
Rectifier Reports: Displaying data for “Rectifier Current Distributions” or “Linked Facility
Readings Inspections” when no current distributions or linked readings are defined now
functions properly.

Field Computer:









Facility Inspections vs Time Graph Report: Supports the following grouping types with
one type per page: Facility (default), Milepost, Inhibitor Injection Point, or Pipeline. Set a
grouping type in the Options page of the report.

Send Survey/Route - Export List, Exported List: Supports Microsoft Excel file formats
Excel Workbook (*xlsx) and Excel 97-2003 Workbook (.xls).
Receive Data: Receiving data from the Allegro functions properly.
CeFileXfer.exe: Interface file for sending/receiving Periodic Survey (PS) data between PCS
and the Allegro Field Computer has been updated
wToCmd.exe: Interface file for importing Allegro CeCi close interval survey data in PCS has
been updated.

All PCS Modules, continued


Bridge:









Excel Transition Files: Select the .xlsx file format when creating an import transition file
using Excel 2007 or later. For software versions prior to Excel 2007, select the .xls file format.
PCS supports up to 100,000 rows of records when using the Excel .xlsx file format and up to
64,000 rows of records when using the Excel .xls file format.
Import, Print Preview: Bridge import and print preview function correctly.
Import, Export: Supports Microsoft Excel file formats Excel Workbook (*xlsx) and Excel 972003 Workbook (.xls). Now uses the same third party utility as PCS Axis® to read and write
Excel Workbook (*.xlsx) files.
Bridge Log and Bridge Preview Print Grid: A numeric overflow error no longer occurs.
Data is now truncated to fit allowed data length.

Synchronization:


Hierarchy Reorganization: Reorganizing the hierarchy on the master and/or replicas, then
synchronizing, functions properly on the master and/or replicas.
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Internal Corrosion Manager (ICM):






Logging Activity: Logging synchronization activity functions properly.

New Multi-Select Field “Inhibitor Injectors”: New field available for use in the ICM
Coupons, Samples, and Probes data entry grids. Clicking the field's ellipsis button (…) opens a
dialog box with available selections.
Inhibitor Injection Links: Field now shows all currently selected links regardless of Selected
ROWs as well as available links when based on Selected ROWs.

Indirect Survey Manager (ISM):


CI Survey Graph: More than five close interval (CI) surveys can be graphed at one time.



Test Point Graphing: Graphing test points functions properly.



Rubber Banding: Handles partial-foot value points properly.
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PCS 7.5.1 / January 2014
Software enhancements and fixes available in PCS 7.5.1 include those in the following list:


PCS Application, Data Folder/Database, and Documentation Installation:








Based on the target computer (32- or 64-bit), the PCS application installs in the following
location by default unless changed during the installation:


32-bit computer installation path: C:\Program Files\PCSv7\



64-bit computer installation path: C:\ Program Files (x86)\PCSv7\

By default the PCS installation creates a data folder labeled “PCS 7 Data” in “My Documents”
with an empty database in the following location unless changed during the installation:
C:\My Documents\PCS 7 Data\.
A single PCS installer now installs the application, database, and documentation. A separate
installer for installing documentation is no longer required. PCS installs documentation in the
following location on your computer:


32-bit computer documentation path: C:\Program Files\PCSv7\manuals



64-bit computer documentation path: C:\ Program Files (x86)\PCSv7\manuals

Routes:

Linked Rectifiers: Deactivating a pipeline segment with a linked rectifier that is included in a route
no longer removes the linked rectifier from all routes.


Synchronization:






Routes: Facilities added to an existing route for a pipeline segment not previously included in
the route now process correctly during synchronization. Facilities are no longer rejected during
synchronization and subsequently omitted during Sync & Verify.
Server Mode: A timing issue that resulted in the displayed message “Record Out of Range”
when attempting to log conflicts during Sync & Verify has been fixed.
Replica Database: An issue with the replica database structure causing problems during
synchronization has been fixed. The replica database structure is now created correctly when
generating a backup.

IMPORTANT: Users with a previous version of a replica database prior to PCS v7.5 that have

not synchronized with the master database should create a backup or get a new backup from
the master database.



Bridge Import: An issue with Bridge Import incorrectly creating new ROW Links when using an
External ID and Series has been fixed.



X-axis in Test Point Graph Report: An issue with rectifier events not showing on the X-axis of a test
point graph has been fixed. PCS v7.5.1 corrects this issue for rectifier, bonds, and mag beds when
graphing test point data.
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PCS 7.5 / September 2013
IMPORTANT NOTICE: If the server and replica(s) are installed with PCS Hotfix v7.4.1, uninstall the hotfix

before installing PCS v7.4.4. Delete the file labeled _pcs.app in the CPDM executable directory (typically at
C:\CPDM\_pcs.app) to uninstall PCS Hotfix v7.4.1.
Software enhancements and fixes available in PCS 7.5 include those in the following list:


New ZIP Utility:

Previous issues with “Backup Data” and “Restore Data” have been resolved with a new third-party
ZIP utility. Other system features using the new utility include: Import Data, Export Data,
Synchronization, Replica backups, and exporting to IMP/RIPL.


Synchronization:








Synchronize and Verify: An improved method is now used to resolve conflicts between the
master and replica databases when a field is out-of-sync. If a replica change log record is found
showing the last change was made on the replica, the master database is updated.
Error Related to Change History Archives: It is no longer necessary to rename, delete, or
create archives in order for some synchronizations to function properly.
Error message “Field COMID Does Not accept Null Values”: This error was due to a
rectifier link not set to a pipe. The system now detects the condition and works without an error.

Replica:


Generating Replica Backups:





Generating a replica backup is now faster.
“Replica Management” window no longer needs to be closed after generating a replica
backup.



A deleted custom module on the master no longer causes an error during generation.



Saving the replica backup to a path with spaces now places the file in the correct location.





New dialog box provides users the option of selecting whether to include or exclude change
history data (changlog and arcchglog) when generating a replica backup.

A replica can no longer modify the “range checking” flag in “Field and UDF Customizations”.
The flag creates associated min/max fields as needed, which is not a valid operation on a
replica and caused an error during synchronization.

Data Modification Utility:
Running “Mass Create” from a replica no longer displays a message about missing “Base
Effective Date” records. These records are now created by the Data Modification Utility (DMU).
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System Settings:


Duplications / System Lockup: To prevent system lockups, existing databases with duplicate
records will need to be cleaned up manually.
This update changes how synchronization handles config table records. Synchronization is now
based on the setting key instead of an ID. This prevents duplications seen in previous software
versions due to the conversion creating mismatched IDs on the master and replicas.



Bridge Import:








Performance: Some Bridge imports will see speed improvements of up to 10 times faster than
in previous software versions.
Import Voltage Conversion: The setting for “Import Voltage Conversion” is no longer lost
when clicking back to transition fields and modifying selections.
Perform Range Checking & Perform Criteria Checking Options: Setting up a Bridge
import file includes two new options you can apply to each data item in the import file. When
these options are enabled, the Bridge Error Log identifies imported values that are outside
established range values as well as those that are below protection criteria. When these options
are disabled, the Bridge import process does not verify whether imported values are out of
range or below protection criteria; entries are also not included in the Bridge Error Log. The
Bridge Import options override property settings in the Editing tab of System Settings for “Warn
user when outside of established range values” and “Warn when below protection Criteria”.
Preview Option: Bridge wizard includes a new option labeled “Show preview when bridge is
run manually”. When enabled, preview windows display showing “raw data” and “processed
data”. When disabled or Bridge is run in server mode, preview windows are not available and
the import process functions the same as in previous software versions.

IMPORTANT: Using the Bridge Preview option with a large import when running Bridge can
exceed system limits. In these cases a message displays stating the file is too large and changes
to the database cannot be retracted. The message displays with large import files that include
more than 150,000 rows of facility data or more than 750,000 rows of continuous data. These
limits are also affected by available system resources (memory). Row limits are less if other
memory intensive programs are running. Before running a large import file, first make a backup
of the database. This allows you to restore the database to a state prior to running a large
import if unexpected changes occur in the database.




Preview Windows of “Raw Data” and “Processed Data”: The first preview window is a “raw
data preview” displaying the content of the import file. The second preview window is a
“processed data preview”. It includes filters for displaying new records, existing records, and
records that cannot be imported.
Bridge Log: When all or part of a Bridge import is cancelled when using the Preview window,
the Bridge log includes the words “Cancelled” or “Partial” to indicate the final state for those
Bridge imports. If errors occur during the Bridge import, the log includes the word “Errors”
instead of “Cancelled” or “Partial”.
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Bridge Import, continued

























Additional External ID Fields: In addition to selecting character and numeric user defined
fields (UDFs) as an external ID, the fields “Facility ID” and “Facility.facid” can also be used as an
external ID.
Compress Matching: “Pipe Code” and “Series Number” are now matched using the compress
method used with “ROW Code”. For example, having “1 “and one-space in the import file will
match to “1” and space-one.
Base Effective Date Records: Bridge no longer uses the data integrity check internally (audit)
to build “Base Effective Date” records. It now creates these records instead. Previously this
caused an issue with replicas because replicas are blocked from creating “Base Effective Date”
records in an audit.
Blank Required Fields: A blank “ROW Code”, “Milepost” or other required field in the import
file no longer causes an error when bridging data. These fields are now marked as “rejected”
and can be viewed in the “Bridge Preview” window.
New Bridge Setup Option “Match to existing inspections/maintenance on date only”:
The new option is available for matching data using only the date and not the time in the field
“Inspection Date and Time”. It applies when importing inspection, maintenance, and sub-grid
inspection data such as negatives.
Bridge Setup Options “Assign inspections to an Annual Survey” and “Assign inspections
to a Periodic Survey”: These options are no longer visible when they do not apply to the
import. Previous versions showed these options as disabled.
Bridge Log Errors: Errors previously dismissed during import are now included in the log.
Unmapped Default Location Format: Bridge no longer encounters an error when the field
“Default Location format” is not mapped and the import file includes different milepost formats.
Long series of duplicated record numbers are also not logged.
Column Names with Spaces or Special Characters: Import files with spaces or special
characters in column names trigger a rule violation. The rule violation displays when using the
Bridge wizard and when running the Bridge.
Caching of Large Import Files: Import files selected for import in the Bridge wizard and
when running a Bridge import are now cached. Import files are only re-cached when they have
changed (newer date/time stamp).
Column Names with “ON” Heading: Having a column named “ON” in the import file no
longer causes a system error message. It now generates a rule violation in the import file which
subsequently prevents running the import file.
Excel File Read Error Message: A more informative message now displays when PCS is
unable to read an Excel file. The message now identifies possible causes of the error, such as a
missing Excel “Sheet1” worksheet.
Importing Mixed Case Hierarchy Levels: Running a Bridge import of hierarchy levels 2
through 5 that includes hierarchy level names with mixed case letters no longer causes an error.
These are now converted to all uppercase letters.
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Bridge Import and Export:









Bridge Export: Exporting too many columns no longer causes an error. This event is now listed
in the Bridge Error Log.

Filters in Send to Allegro: Customizing filters no longer causes problems. Filter content is
now based on what is saved in the filter definition.
Pipeline Current On/Off: These fields are now flagged as an on/off pair for the Allegro.

Reports & Graphs:










Bridge Log: The log is now synchronized. The “View Log” window also includes information
that identifies who was logged in when Bridge was executed and the replica (or master) that
Bridge was executed from.

Allegro Field PC:




Scheduling Facility Type Inspected: Data in this column is now bridge-able.

Blank Custom Report Name: A custom report without a defined name no longer causes an
error in PCS. It is labeled as “<Blank Menu Caption>” in the menu item's caption. A message
also displays notifying the user of the problem and where to find the report each time the user
accesses the menu.
Graphing CIS Native: Can now include “Remarks” when graphing “CIS Native” data. This
improvement also allows remarks to be included with other fields such as “Structure IRF”.
CIS Catalog Report: Exporting large surveys no longer causes an error during the export
process. A similar improvement was applied in “Survey Maintenance” to the field “Number of
Readings in Survey”.
Current Density Analysis & Summary Reports: Calculations are now performed on the
“Left” currents if adjusted, otherwise “Found” values are used.

Define Routes:

A rectifier linked to an active ROW and an inactive ROW is no longer removed from routes.


Attached Documents / Olelink 2GB Limit:

Olelink memo files are now packed each time a linked document is viewed.


Export Data (File menu):

A ROW-level memo type user defined field no longer causes an error during the export process.


Software Installer:

Click-through license has been updated.


PCS Version 6 to 7 Conversion:

The time conversion in the field “Inspection Date and Time” is no longer damaged during
conversion.
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PCS 7.4.4 / October 2012
IMPORTANT NOTICE: If the server and replica(s) are installed with PCS Hotfix v7.4.1, uninstall the hotfix

before installing PCS v7.4.4. Delete the file labeled _pcs.app in the CPDM executable directory (typically at
C:\CPDM\_pcs.app) to uninstall PCS Hotfix v7.4.1.
Defect Resolution:


Backup/Restore Issues in Newer Operating Systems: The executable file pkzipc.exe has been
updated with the latest PKWARE version. The updated file resolves issues when running PCS
Backup, Restore, or Import on newer operating systems, such as Vista and Windows 7.



Range Checking Modifications on a Replica Cause Synchronization Errors: Modifications to
“System-Range Checking” in Field & UDF Customizations on a replica have been updated to resolve
issues causing synchronization errors. Range checking is now disabled on replicas and can only be
modified on stand-alone and master databases.

PCS 7.4.3 / April 2012
Synchronization: A synchronization initialization timing issue has been fixed.
IMPORTANT NOTICE: If the server and replica(s) are installed with PCS Hotfix v7.4.1, uninstall the hotfix
before installing PCS v7.4.3 or v7.4.2. Delete the file labeled _pcs.app in the CPDM executable directory
(typically at C:\CPDM\_pcs.app) to uninstall PCS Hotfix v7.4.1.

PCS 7.4.2 / March 2012


Bridge:








Using Bridge to export and import data in the In-line Inspection Manager module (ILIM)
completes successfully.
(TFS 3905, 3908)
Creation of change log records during Bridge imports process more efficiently.
(TFS 8434)
Bridge imports with the option “Create new record for each import record” process correctly.
(TFS 9257)

Synchronization:






Performance enhancement for processing large datasets.
(TFS 8432)
Messaging improvements during sync and verify.
(TFS 8430)
A synchronization error that occurred during verification when a change log record was
retrieved from an archived change log has been corrected. Archived change log files no longer
need to be renamed to allow for a successful sync and verify. Any archived change logs that
have been renamed can now be renamed back to their original name.
(TFS 8520)
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Synchronization, continued:




An error no longer occurs when a field value is changed and then changed again to the original
value.
(TFS 8504)

PCS Hotfix v7.4.1:

If the server and replica(s) are installed with PCS Hotfix v7.4.1, the hotfix must be uninstalled before
installing PCS v7.4.2. Uninstall the hotfix by deleting the file labeled _pcs.app in the CPDM
executable directory (typically located at C:\CPDM\_pcs.app).
(TFS 8457)

PCS 7.4.1 Hotfix / February 2012
Synchronization:






Synchronization no longer fails when a ROW is removed from a replica definition.
(TFS 8429)
A misnamed property no longer generates an error message when the master database or
replica is zipping a synchronization file.
(TFS 8433)
The message Server Busy Error displays and the synchronization log reports the messages
Server Abnormal Termination and Program: Changlog.
(TFS 8431)

PCS 7.4.0.4 / January 2012


Sync and Verify: Sync and verify in Two-Synchronization works correctly when Export Setting fields

in System Settings are disabled or enabled.


Linked Documents: The grid field Facilities Linked Documents now supports file names with up to

240 characters.

PCS 7.4.0 / November 2011


Archive Change Log Records: Automatically archive all archivable records for the master database at

a user-defined time.


Inspection GPS Fields: Added the following new fields in grids, reports, Bridge, and field computer

prompts: Inspection Latitude, Inspection Longitude, Inspection Elevation, and Inspection GPS
Accuracy.


RFID Field: Added RFID field to support RFID data in Periodic Survey file transferred from Allegro

MX.


Reduction in Change Log Record Creation: The process for detecting and managing change log

records during replica synchronization with the master database has been optimized.
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Schedule Report Customization: The report layout can be customized when scheduling facilities by

ROW; select from a list of report fields in the Selected Fields pane of the Layout tab.


Database Cleanup: Instead of logging each shunt reset performed during the Database Integrity

Check, the message Reset # invalid readings to null is added in the audit log when the conversion
process is completed.


Bridge:










Importing with Facility Location Format Overrides: Syntax error no longer occurs when
importing Facility Location Format overrides.
Import/Export Scheduling: Scheduling Bridge to automatically run between 12:00pm and
12:59pm executes correctly.
Importing Data in an Excel File: Supports Microsoft Excel 2010 file formats in a Windows 7
32-bit and 64-bit environment.

Email Notification:








Importing in ISM: Mandatory fields populate correctly when generating a Bridge import in
ISM for a continuous survey.

Event Reports: When an event is assigned to sections of the hierarchy with no schedulable
facility types, an error no longer occurs when the Email Notification process returns zero results.
Event Assignment Scheduling: An issue with Email Events scheduled to automatically run
between 12:00pm and 12:59pm has been fixed.
Reports: Email Notification reports sort in ascending in the following manner: Range Violation
report sorts by Date; Pending Due Dates report sorts by Due Date; Delinquency Dates report
sorts by Delinquency Date; Criteria and Range Violations sort by Inspection Date and Time.

Reports/Graphs:




Graph Reports: WiGraf executable (wigraf98.exe) has been updated to allow for driverless
operation on any Windows system running PCS graph reports.
Summary Reports: The report supports a Count summation for open maintenance items
when the report is set up to include the optional setting, Summation Filter for the fields Repair
Corrected Date and Is missing.



Synchronization: The command Syntax error in Server Mode has been corrected; master
database and replica(s) synchronize data successfully.



Version 6 to 7 Database Conversion Fixes:


Event Assignments in Email Notification: Event Assignment is included in the topmost
hierarchy level (typically Company Name) when all ROWs are assigned the same Event
Assignment.
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Version 6 to 7 Database Conversion Fixes, continued:


Rectifier Anode Conversion: Rectifier anodes convert correctly.



Rectifier Negative Conversion: Rectifier negatives convert correctly.











ROW Schedule Settings: All ROW Schedule Settings in Edit Schedule Settings transfer
correctly and link to the correct facility type. Schedule definitions in Define Schedules do not
convert and should be redefined after the database conversion.
Schedule Facility Type Conversion: Schedule settings for all facility types in Edit Schedule
Settings transfer correctly.
Facility Information Grid/Scheduling Facility Types: Facility schedule settings in the
Scheduling Facility Types mini-grid of the Information grid in Edit Data by Facility transfer
correctly.
Shunt Ratings and Factors: All shunt ratings and shunt factors update in a v6 to v7 database
conversion.
Population Classifications: Population Classifications for PLSM facilities now transfer to blue
Facility Population Classification fields.
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Product Support and Training
If you have a suggestion, question, feature request, or a bug to report-your feedback would be
appreciated. Also if you have a training need for your organization or would like to know more about
upcoming PCS training classes, use any of the following contact information to reach PCS Technical
Services:
Support E-mail:pcstechservices@aiworldwide.com
Support Telephone:1-800-229-3404
American Innovations:http://www.aiworldwide.com
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